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Foreword

Imagine a virtual universe built by a global community of artists, coders, storytellers, and 

everything in between. In this dream, people from all corners of the world come together 

to create and share millions of experiences with their friends and learn from one another. 

It would be a universe driven by imagination, where anything could be made and experi-

enced, regardless of device, location, or time period. What if I told you this digital utopia 

has been a reality for over a decade?

When Erik Cassel and I co-founded Roblox in 2004, our vision was to create an immersive, 

3D, multiplayer, physically simulated space where anybody could connect and have fun 

doing things together. In the early days of Roblox, we were fascinated by what people were 

making. We saw experiences where people wanted to manage their own restaurant, survive 

a natural disaster, or imagine what it’s like to be a bird. Seventeen years later, as I gaze into 

the future, it’s obvious this platform can become so much more.

Roblox is ushering in a new category of human co-experience, blurring the lines between 

gaming, social networking, toys, and media. Our team has found that the millions of daily 

Roblox users aren’t just logging on to play games but are coming together to build commu-

nities, stories, and experiences with friends and strangers alike. 

As we continue our mission to build a human co-experience platform that enables shared 

experiences among billions of users, there has never been a better time to join a global com-

munity of creative individuals who are contributing such amazing works to our platform. 

Developing 3D experiences is not only fun, but it also provides the skills and knowledge to 

launch a career in computer science, design, art, and so much more. Many top developers 

on our platform have used the money they earned from their creations on Roblox to pay for 

their college tuition, start their own game development studios, or put a down payment on 

a house for their parents. 

I believe that ultimately Roblox will lead us to the creation of the Metaverse, a full-fledged 

digital reality that will complement our physical one. We can start to imagine a day where 

people aren’t just coming to Roblox to play and socialize but also to hold business meet-

ings or go to school. As the possibilities of the Metaverse increase by the day, so too does 

the need for innovative and creative developers who can shape the experiences we’ve been 

dreaming about in science fiction for years.
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I personally invite you to join the world of Roblox not just as a player but also as a creator. 

Learning to develop both games and immersive 3D experiences can help connect millions 

of people worldwide through the power of play and create a community not defined by 

borders, languages, or geography. If you’re at all interested in coding, game design, or the 

immersive 3D world of Roblox, consider peering through these pages and embracing your 

wildest, most creative ideas. The Metaverse depends on creators just like you.

Your imagination awaits,

David “Builderman” Baszucki

Founder + Chief Executive Officer

Roblox Corporation
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As the reader of this book, you are our most important critic and commentator. We value 

your opinion and want to know what we’re doing right, what we could do better, what 

areas you’d like to see us publish in, and any other words of wisdom you’re willing to pass 

our way.

You can email or write to let us know what you did or didn’t like about this book—as well 

as what we can do to make our books better.

Please note that we cannot help you with technical problems related to the topic of this book.
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name, email address, and phone number. We will carefully review your comments and 

share them with the author and editors who worked on the book.
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Reader Services
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 H OUR 1
What Makes Roblox Special?

What You’ll Learn in This Hour:

How Roblox empowers social connectivity

How Roblox manages user content 

How Roblox enables fast prototyping and iteration

What’s inside Roblox’s engine

Welcome to Roblox! With this free online 3D platform and game creation system, your only lim-

itation is your imagination. Anyone can create and play unique games in a vibrant and inter-

connected social environment. There are millions of worlds to choose from, all created by users 

who bring their own unique style of gameplay, design, and communities. In this hour, you’ll 

learn about the features Roblox provides for you to begin making your own expertly crafted 

game. Knowing the capabilities of Roblox will set you in the right direction. 

Roblox  is an all-in-one platform. In other engines, being a developer means you need engine 

code, moderation, and more. Luckily, Roblox handles all of that for you. Its infrastructure takes 

care of the dirty work, including server hosting and multiplayer networking, which leaves you 

with more time to create. A single account is all you need both to play and create.

The Roblox platform provides a built-in audience of millions of daily visitors with built-in mod-

eration, cross-platform play, and a hard-coded currency called Robux . This means developers 

can focus on what matters most, creating new engaging experiences for players around the 

globe (Figure 1.1). 
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FIGURE 1.1
Welcome to Roblox.

To publish games, you don’t need years of coding experience or expensive software licenses, and 

you don’t have to complete a lengthy submission process. All you need is a PC or Mac, a stable 

Internet connection, Roblox Studio, and a bit of imagination, and your game can be published 

in minutes—for free. 

As your game and player base grows, you can exchange the Robux you earn through player 

purchases in your game for  real-life cas h.

Roblox Empowers Social Connectivity
On Roblox,    social connectivity is valued. Games can range from highly detailed hangout places 

to competitive edge-of-your-seat gaming experiences.

Also, because Roblox is cross-platform, anyone can play, whether they are joining on a PC, Mac, 

or even a mobile device. No one is excluded. To encourage social connection, Roblox provides 

the ability to add friends, chat together, and emote. Together, players explore worlds, solve puz-

zles, and even watch performances by their favorite musicians.

Roblox as a Social Website
Users in    Roblox can create Groups to organize their social experience. Each Group has a page 

(Figure 1.2) where users can host their own games, sell virtual merchandise, and associate with 
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other Groups, all while maintaining a unique identity. It’s also common for Groups to be used as 

a brand hub where teams can combine their resources for development. 

FIGURE 1.2
A       game development Group page with their external social media links.

Roblox as a Creator Hub
Roblox    provides ways for developers to connect with each other. The Roblox Developer Forum  is 

an online forum where Roblox developers can discuss topics and exchange services. To join the 

Developer Forum, you just need to regularly browse and read the content in it. After you’ve spent 

enough time browsing and reading the resources, you will automatically level up (from visitor to 

member and even to community sage) and can start making your own posts.

Roblox has a real-life invite-only convention: the Roblox Developers Conference . At this confer-

ence, featured developers and members of the official Roblox team give speeches and presenta-

tions about their advances on the platform. You’re not alone on your development journey!

The Annual Bloxy Awards , a yearly awards livestream and game-based ceremony, is another event 

that boosts the identity of Roblox as a social game. Roblox creators are nominated and awarded 

based on the community’s vote in this event to win a virtual one-of-a-kind trophy. You can read 

more about these events in the official Roblox Blog  (Figure 1.3) at https://blog.roblox.com/ and 

the    DevForum.

https://blog.roblox.com/
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FIGURE 1.3
A blog post       featuring the 6th Annual Bloxy Awards in 2019.

Roblox Manages User Content
Roblox     is very hands-free on the concepts that players can design, so you have the freedom to 

let your imagination run wild. Just about everything on Roblox is tied to a user account; games, 

cosmetics, plugins, and game assets are only some of the things that users can upload. Users 

have nearly complete freedom to decide what they want in their games. 

NOTE

All Uploaded Assets on Roblox Must Pass Moderation
All content    on Roblox must pass through a moderation check before it’s allowed to be displayed to 
players. Users can also report anything deemed inappropriate so it can be flagged and deleted. This 
is not limited to your games and assets, but your account as well. It is encouraged that you read 
Roblox’s   rules and Terms of Service (https://en.help.roblox.com/hc/en-us/articles/115004647846-
Roblox-Terms-of-Use) in the support section to learn more about moderation.

Organizing Content 
Roblox    has built-in organization for certain assets and products uploaded onto the website. 

Things you made will be in your Create page  (Figure 1.4) and everything you obtained will be in 

your Inventory.

https://en.help.roblox.com/hc/en-us/articles/115004647846-Roblox-Terms-of-Use
https://en.help.roblox.com/hc/en-us/articles/115004647846-Roblox-Terms-of-Use
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FIGURE 1.4
The Create page , including Developer Resources with links for Roblox Studio,      the official Developer Wiki 
(Docs), and the DevForum (Community).

From the Create page, you can also access the Asset Library  (Figure 1.5), which provides  things 

such as Models, Decals, Audio, Meshes, and Plugins.

FIGURE 1.5
The Asset Library , where assets are on      display.

Creating Your Identity
Don’t     forget that Roblox is a social website. Developers can create and upload images such as 

icons, thumbnails, and even advertisements to display on the site (Figure 1.6). You can use exter-

nal tools of your choice to create a custom visual and upload it. These features are what gives 

groups, games, and characters on Roblox a diverse set of identities.
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FIGURE 1.6
User-uploaded images on Arsenal’s game store tab       for micro-transactions (Arsenal by ROLVe Community).

Customizing Your Characters
The        Avatar Shop, also called the Catalog (Figure 1.7), is where users can purchase virtual items 

for their avatars, such as hats, heads, gear, accessories, and other items. Although the official 

Roblox account has been responsible for Avatar Shop content, the creation of shirts, t-shirts, and 

pants have always been in community hands. They have been considered core parts of fashion 

design groups and identity-focused clubs. Because Avatar Shop content items are assets with 

their own IDs, developers can load them onto Studio for their games.

FIGURE 1.7
Categories and some cosmetics on the catalog        of the Avatar Shop.
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Figure 1.8 shows a player’s inventory featuring sections of catalogs for what they made and own, 

such as assets from the Asset Library and Avatar Shop.

FIGURE 1.8
A player’s        inventory.

Starting in August 2019, select users have been able to upload their own hats in the Accessories 

category   , making it the first instance of users being able to upload hats. (Over time, this feature 

will be rolled out to more users.) Some hats require Premium to purchase. 

Roblox has    two official avatar rigs: the legacy R6 and the newer R15 Rthro. Both may use Avatar 

Shop cosmetics. Custom rigs may also be    uploaded via Models but may require editing in-engine 

with Roblox Studio before being fully compatible for your        game. 

Roblox Enables Fast Prototyping and 
Iteration
Roblox is    a flexible engine that maximizes your time to create. Roblox games use a language 

called Lua that requires no compiling. You can switch from coding to testing in a flash. Roblox 

also has error outputs and a command bar that can run in live games, which helps with debug-

ging. All raw Studio sessions begin with systems for players, rigs, animation, movement controls, 

lighting, multiplayer, and some UI features. Roblox Studio  provides the tools to tinker with any 

of these, alongside some external tool and software support. Your Roblox game can enhance any 

of these defaults or move away from them.
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Ready to Be Modified
Roblox Lua    enables the manipulation of already existing properties. Properties determine how 

objects look and function. These properties are prevalent in many class objects. For example, 

properties include the shape, color, or even material of an object. 

Take this primitive shape, known as a Part , for example. In Figure 1.9, you can see its properties, 

including the color as medium stone grey and the material as plastic.

FIGURE 1.9
Some properties of a part as shown in       Roblox Studio.

Elements of these properties that aren’t grayed out can be modified through code or by the user. 

You can alter the properties of not only 3D objects but of anything else that you can place and 

use in Studio, such as particle emitters or user interface frames. Having the know-how about 

what properties can be used on Roblox will help you open your mind to more complex games. 

We talk much more about parts and properties, beginning with their introduction in    Hour 2, 

“Using Studio.”

Conceptualize with Ease
You can find free assets to help you get started in the Toolbox  . They are streamed and then 

loaded in real time, so you don’t need to install them. You can then combine them with manip-

ulatable primitives, such as texturable blocks and spheres, to test new concepts or play around 

(Figure 1.10).

If working with just blocks isn’t your style, you can sculpt levels with Roblox’s Terrain Editor  (Fig-

ure 1.11), which optionally includes foliage.
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FIGURE 1.10
A blockout test environment from using     parts, free assets, and modified property settings.

FIGURE 1.11
Using the Terrain Editor in Roblox Studio    to sculpt an environment.

Roblox has signed a license agreement with APM Music     that provides thousands of audio tracks 

from APM to be played only in games with no worries of copyright claims. If you need a certain 

soundtrack, search the audio from APM uploaded by Roblox to find what you need.

Plugins
Roblox Studio   supports the ability to install user-created plugins to enhance your experience in 

developing. Developers have made their own tools, their own content installers, or external soft-

ware support interfaces. Some plugins will allow you to generate trees, fill gaps when it might be 
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otherwise tedious to do so, scan for viruses, and even edit light inside of objects. Roblox’s official 

plugins include a language translation software, and animation and rigging tool for characters. 

No Wait Times for Publishing or Updating
Roblox   is hands-free when players want to schedule something new for their games. Updating a 

game doesn’t require contacting a middleman or retailer. Every Roblox game has a Configura-

tion page  for both Places and Games. 

In games received from regular online retailers, it’s expected that users will install updates when 

they are released. Not on Roblox! Because assets are streamed, like during a Roblox Studio ses-

sion, updates also will be streamed when players start joining and loading up your game. This 

does not extend to the Roblox client itself because new software updates to the platform occa-

sionally install onto your   device.

What’s Inside Roblox’s Engine 
Roblox’s   engine, Roblox Studio, provides a lot of components that other engines would have the 

player make themselves. This makes developing on Roblox less expensive in terms of time and 

resources. As a designer, you can share your projects so users can experience them quickly with 

little hassle. 

Networking
Roblox is   responsible for server hosting and has already provided online connectivity services 

for you. Getting your game online is easy because you don’t have to tinker with hardware or 

software outside of Roblox. Server hosting   is automatically established as soon as games are 

published. Hosting can be private or public and can range from playing solo to playing with 100 

players maximum. The number of players is set by the developer through the website. For well-

balanced performance, a player cap of 20 or 30 is practical for an action-packed environment.

Roblox Lua   supports web services that will help connect Roblox games with real data from the 

Internet. HTTP Service  can be used to connect a Roblox game with third-party services and can 

provide things such as analytical data. Another form of this is called Asset Service , which can 

load asset data from the Roblox website, like a catalog item’s description or creator name, into a 

live game. 

Roblox    also provides developers with a security measure called Filtering Enabled, which forms a 

client-server structure for games and prevents clients from replicating things onto the server, thus 

reducing the abilities of exploiters and hackers. Adding additional game security is up to the   

developer.
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Physics
Roblox   has its own physics simulation engine so your environments and assets can be as dynamic 

as ever. Every 3D object in Roblox can have physics with toggleable collisions. Meshes automati-

cally   generate their collision meshes upon loading but can be limited to their hull or a bounding 

box for performance purposes. To disable simulated physics  on something, it must be Anchored. 

Constraints  and Attachments  are provided in the Roblox engine, such as ropes, springs, welds, 

and more (Figure 1.12). These can result in some complex contraptions with coding. Vehicles, 

hydraulics, and suspension systems are all possible with constraints. You can put them on parts 

and other 3D objects to help gain better control of physics (Figure 1.13).

FIGURE 1.12
An explosion   affecting an environment built out of welded parts, accompanied by custom UI.

FIGURE 1.13
Players build boats using materials of different density to find out what floats. Build a Boat for Treasure by 
Chillz Studios.
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Rendering
Visual    fidelity on Roblox can support all sorts of environments for any game. Lighting shaders 

 on Roblox support atmospheric fog, particles, real-time lighting, shadow maps, ambient occlu-

sion, anti-alias, and various screen effects (Figure 1.14). Roblox also has the capability for physi-

cally based rendering, ready for shaders such as normal maps and metal/roughness. 

All these systems work with predetermined sets of  graphics options on a scale of 1 to 10. Rob-

lox allows users to set graphics to automatically change these levels higher or lower based on 

a user’s performance. Additionally, games can be streamed, where players will be loaded in 

instantly, at the cost of letting things load as the player encounters them in the game.

FIGURE 1.14
Recreation of the Roblox headquarters.

NOTE

Developers Design the World
The   look and feel of a game is completely up to you. You can even change the provided user inter-
face and player avatars. Although Roblox is often portrayed as a 3D universe, 2D experiences are 
possible as well. 

Cross-Platform Support
Roblox is   supported on multiple devices with cross-platform support. That means a user on a 

tablet can meet with a user on a different device, such as a console, in the same game! Develop-

ers can prepare their Roblox games to be run on any of the following devices: 
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 macOS computers

 Windows PCs

 iOS and Android devices

 Xbox One

 Virtual reality headsets

Roblox originated as exclusive to desktop computers, and trends and core features were built 

for such. To make games built to run outside of the desktop spectrum, you must account for the 

different specifications of your preferred devices, such as user-interface scaling and input. Studio   

supports device simulation, so it’s possible to test games in a cross-platform environment before 

releasing them (Figure 1.15).

FIGURE 1.15
Device simulation using a mobile phone     interface.

Free, Free, Free
There’s   huge potential for a game developer who’s able to access an already existing market 

with no server-maintenance costs, a game engine, your own social pages, and a generous offer 

of cloud-storage—all for free! This can put you at an advantage in time and cost compared to 

working with another engine. Remember that Roblox will not make you pay upfront to utilize its 

game development tools, such as Roblox Studio.

The most you’ll have to interact with monetary hurdles on Roblox is usually for extending social 

and economic features such as deeper avatar customization and getting more Robux  to partici-

pate on the site more. Additionally, entering the DevEx program to exchange your virtual cur-

rency for real currency requires a Premium subscription, which will in turn support the upkeep   of 

Roblox. 
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Unlimited Possibilities
Roblox    houses all sorts of game genres and projects. There is no definition on what a real Rob-

lox game is. There are only Roblox experiences. You’re not limited to common categories and 

you can even go design your own type of genre if you desire. Some trending games on Roblox 

include round-based minigames, open-world experiences, technical experiments, and art port-

folio showcases (Figure 1.16).

FIGURE 1.16
Dungeon Delve by Roblox Resources.

Express Your Own Aesthetic
Outside of    the Roblox brand and some default assets provided, Roblox does not promote a spe-

cific aesthetic. The look and feel of games is completely up to developers. As such, Roblox games 

employ a wide range of visuals, from very quirky and cartoon environments (Figure 1.17) to very 

sophisticated realistic experiences (Figure 1.18). There’s something for everyone. 
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FIGURE 1.17
In World // Zero by Red Manta, bright colors and custom characters come together in a cartoony fantasy 
MMO.

FIGURE 1.18
Jump, explore, and collect candies in the retro world of Robot 64 by zKevin.



16 HOUR 1: What Makes Roblox Special?

Summary
In this hour, you’ve learned about the culture and features that make Roblox a standout plat-

form. Being able to communicate using the site’s social features and understanding how to use 

what Roblox has provided for you is a great first step toward having a presence in the develop-

ment community. Remember that every developer has started somewhere, and knowledge about 

the platform is a great start in taking advantage of more technical topics.

Q&A
 Q. Can I advertise my Roblox career outside of Roblox?

 A. Yes,     you can use other websites to enhance and grow your audience as long as you don’t 
violate the Roblox rules and Terms of Service (https://en.help.roblox.com/hc/en-us/
articles/115004647846-Roblox-Terms-of-Use). 

 Q. How is copyright handled on Roblox? 

 A. All   expected copyright laws apply on Roblox. Using intellectual properties that were made by 
someone else can be grounds for moderator action, especially if you have monetized those 
things. This extends to content made outside of Roblox. If certain copyright permissions are 
granted, you may use it to the said extent in your work if obtained in that period.

 Q. Can I ask Roblox to make a feature for my game?

 A. Roblox    will remain hands-free on the development of content. If you want  to suggest fea-
tures for the platform as a whole, you may do so in the Developer Forums. 

Workshop
Now that you have finished, let’s review what you’ve learned. Take a moment to answer the fol-
lowing questions.

Quiz
 1. How do you join the Developer Forum?

 2. What technology is used to store Roblox’s assets?

 3. True or False: Playing and developing on Roblox requires only one account.

 4. Aside from a game engine platform, Roblox can be associated as a(n) _____ platform.

 5. True or False: I will need to pay to give an uploaded asset its own page.

https://en.help.roblox.com/hc/en-us/articles/115004647846-Roblox-Terms-of-Use
https://en.help.roblox.com/hc/en-us/articles/115004647846-Roblox-Terms-of-Use
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Answers
 1. Regularly browse and read the various content in the Developer Forum. After you’ve spent 

enough time browsing and reading the resources, you will automatically level up (from visi-
tor to member and even to community sage) and can start making your own posts. 

 2. Cloud storage.

 3. True. Developers have the same accounts as players.

 4. Social. 

 5. False. All creations and assets automatically get their own page when uploaded.

Exercises
Follow the    exercise below to make a Roblox account on a desktop computer. You only need one 
account to start developing and playing. 

 1. On a web browser, go to https://www.Roblox.com.

 2. If prompted, apply your correct birthday by clicking on the month, date, and year drop-down 
buttons.

 3. Create a unique username. This will be your online name. It must be 3 to 20 characters 
(letters and numbers). Do not reference anything that could compromise your privacy, such 
as your real name. 

 4. Create a password that only you can memorize. It must be at least eight characters long.

 5. If prompted, select your preferred gender. This will be used to give you free items associ-
ated with your preference on Roblox.

 6. Read the Terms of Use and Privacy Policy to understand them.

 7. Click Sign Up to be able to explore and use Roblox. Welcome to your home page!

Follow the bonus exercise to add some security to your Roblox account and take your first step to 
personalize it a bit. You will need an email address, your guardian’s permission if you’re younger 
than 13, and an Internet connection.

 1. On the top navigation bar, click the gear icon, and click Settings in the drop-down menu.

 2. Select the Account Info tab.

 3. Select the option to add your email address or your parent’s email.

 4. Enter your email address or ask a guardian to add their email address if such permission is 
needed. Verify your credentials and enter your email.

https://www.Roblox.com
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 5. Roblox sends a verification email to the address you entered. Gain access to the email 
account and verify your Roblox account. 

 6. Return to your Settings page.

 7. Add a description to appear on your profile page. Don’t add information that will risk your 
privacy. Get    creative!



HOUR 2
Using Studio

What You’ll Learn in This Hour:

How to install and launch Roblox Studio

How to use Studio templates

How to navigate game editor

How to create a part 

How to translate, scale, and orient parts

How to save and publish your project

Playtesting

Now that we’ve explored the culture and features that make Roblox special, you can start to 

unleash your creativity with Roblox’s free game engine, Roblox Studio. Roblox Studio  is a play-

ground for developers to create, share, and play their games on the Roblox website. What’s 

great about this platform is that you can easily build everything from volcanic islands to urban 

cityscapes and then drop a character into that world to immediately start playing. Imagine a 

huge playground filled with all the tools you need to build imaginary worlds—that’s Roblox 

Studio.

In this hour, you’ll learn how to install Studio, and then you’ll learn how to use Roblox Studio 

with the help of templates. You’ll also learn how to arrange your workspace to hold objects in 

the 3D world, the difference between saving and publishing your project, and finally how to test 

your game before publishing it to the public.

Installing Roblox Studio
We’ve   explained how Roblox Studio is a free and immersive platform for game developers to 

build different terrains, cities, buildings, race games, and much more. You don’t need years of 

coding experience or a degree to make fun games; all you need is your imagination and hands-

on learning in the Roblox Studio. Roblox Studio is extremely intuitive to use. Because Roblox is 

cross-platform, developers can install Studio on both Windows and Mac systems.
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Use the following steps to install Studio:

 1. Go to https://www.roblox.com/create.

 2. Click Start Creating and then click the Download Studio button in the pop-up window.

 3. Navigate to the folder where you have downloaded Studio and double-click the file to 

install   it. 

NOTE

System Requirements 
For Roblox Studio    to run efficiently, there are some OS/hardware specifications:

 Roblox Studio cannot run on Linux, Chromebooks, or mobile devices such as smartphones.

 A Windows computer with at least Windows 7 installed, or a MacBook with version 
macOS10.10.

 A minimum of 1 GB of system memory.

 Internet access to download Studio and updates. It also lets you save projects (publish) to 
your Roblox account.

For an enhanced Studio experience, you should also have these things (not mandatory):

 A mouse with a scroll wheel, preferably a three-button mouse.

 A video card that’s dedicated and not an integrated card.

Troubleshooting the Installation
If you’ve     followed the necessary steps to install Studio but you’re experiencing installation con-

flicts, there are a few things you can do to troubleshoot the errors:

 If you’ve added new hardware or drivers recently, remove and replace the hardware to 

determine if it’s causing the problem.

 Run diagnostics software and check information on troubleshooting the operating system.

 Restart the computer.

 Uninstall and delete all the Roblox files and reinstall the latest Studio again, if required.

If you are still finding errors, you can also reference the Roblox Support forums online for addi-

tional    tips. 

https://www.roblox.com/create
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Opening Roblox Studio
Once   you are done installing the Roblox Studio, you need to open it:

 1. Double-click the desktop icon if you are on Windows or click the Dock icon if you are on a 

Mac to open a login window (Figure 2.1).

 2. Enter your Roblox username and password.

 3. Click the Log In button.

FIGURE 2.1
Roblox Studio login   window.

Once you are logged in, you see a page with different templates and a menu sidebar with New, 

My Games, Recent, and Archive (Figure 2.2). 

The following sections provide a quick introduction to these templates and the rest of Studio; 

then you can begin experimenting with the utilities of   Studio.
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FIGURE 2.2
Roblox Studio   home screen.

Using Studio Templates
When      you first open Roblox Studio, under New, you see three tabs: All Templates, Theme, and 

Gameplay. Templates are prebuilt projects, and you can use them as a guide to build your own 

game world. 

All Templates
The    All Templates tab (Figure 2.3) is a combination of the Theme and Gameplay tabs. You can 

use these templates as a start for your games. For example, if you’re building a medieval game, 

the Castle theme is equipped with feudal details, or if you want to build an interactive obby, you 

can build off the Obby gameplay template. Two simple templates are a good place to start:

 Baseplate: This  is a popular choice to start with. The baseplate itself is easy to delete, leav-

ing a blank canvas to work with.

 Flat Terrain: Has a  flat plane of grass terrain instead of a baseplate. You can modify or 

clear the terrain using the terrain editor.
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FIGURE 2.3
Roblox Studio home screen lists various templates available,    such as simple templates Baseplate and Flat 
Terrain.

Themes
Themes are     a combination of gameplays and more, and together they make a new world. It sets 

a mood for your game—for example, a space combat game will have asteroids and other galac-

tic components. Roblox provides some prebuilt themes that are ready to use and modify however 

you would like. As you explore the game world, descriptions point out its use case or features, 

including tips on how the effects were created in case you want to re-create them yourself.

An example of a prebuilt theme is Village  (Figure 2.4). You can explore the houses in the village 

and move along the pathway through the town, which leads you to a river, a bridge, and finally 

the dock, across which you can see small islands.

FIGURE 2.4
Example of a prebuilt Village Theme available in      Studio.
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Gameplay 
Some    templates include interactive gameplay. For example, this can include Team Deathmatch, 

Control Points, Capture the Flag  (Figure 2.5), and more. A great thing about these templates is 

that developers can take them apart and extract any specific facet that they want—for example, 

using in-game radar or team spawn points. These templates help with components such as what 

a player can do in a game, what the goals are, and how a game can be modified.

FIGURE 2.5
Example of a prebuilt Capture the Flag gameplay     template.

Working with the Game Editor
Now that   we’ve familiarized ourselves with Studio’s homepage, let’s click on the Baseplate tem-

plate to get started. This opens    the game editor (Figure 2.6).

The game editor is, as the name suggests, a place where you can create, modify, or test your 

game. At the top of the game editor, you see   different tabs on the menu bar (Figure 2.7).
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FIGURE 2.6
The game editor enables you to create,   modify, or test your game.

FIGURE 2.7
Roblox Studio     menu bar.

 Home tab:  A concise tab of all the features that are frequently used. These features are on 

the Home tab for easy access. 

 Model tab:  Has more building tools apart from move, scale, and rotate. It’s also where you 

can create spawn locations and special effects such as fire and smoke.

 Test tab:  Helps for testing your game. There are two options underneath: Run and Play. 

Run will run a simulation of what will happen to the bricks and surrounding elements, 

and Play will let you play your game.

 View tab:  Lets you toggle the different windows available in the Roblox Studio. If you need 

to use a window that is closed, you can find them under the View tab. 

  The main windows are Explorer and Properties, which are discussed detail in later in 

this section. 

  The Actions section has several display features. You can take screenshots or record 

videos here and also toggle between full screen and windowed views.

 Plugins tab: An add-on to Studio. These are generally not included by default. Plugins 

add new custom behavior and features. You can either install plugins made by the Roblox 

community or create your own   plugins.
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Below the menu bar is a   ribbon bar (Figure 2.8). The tool options change as you move between 

menu bar tabs.

FIGURE 2.8
Roblox Studio     ribbon bar.

In the following sections, we explain some of the editor’s basic features and most frequently used 

features and discuss how to prepare your project for publishing on Roblox.

Arranging the Game Editor Workspace 
Since this     is the first time you are opening the game editor, extra windows that you don’t require 

right now will automatically open on the left side. To organize the workspace in an optimal 

way, close the extra windows so you have more space to create. 

By default, the Explorer and the Properties windows will be open (Figure 2.9), aligned one 

beneath the other on the right side. 

FIGURE 2.9
Workspace arrangement       with the Explorer and Properties windows one below the other.
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NOTE

Some Features of the Game Editor Workspace
The next time you relaunch Roblox Studio, your workspace arrangement remains intact. It is a one-
time fix, unless you undo your arrangement.

When the      Property window undocks, it gets difficult to dock it back below the Explorer window. It 
either docks itself aside or over the Explorer window. To fix this, undock both the windows and close 
them. Go to the View tab, open the     Explorer window, dock it on the right-hand side, and then close 
it. Do the same with the Properties window and close it. After all this, reopen the Explorer and then 
the Properties window. This will align them one above     the other.

Working with the Explorer Window
The Explorer window    is the hierarchical representation of all the objects used in your game. It 

is the most crucial window because it lists all the organizing, viewing, and testing features of a 

Roblox game. 

It uses the concept of parenting to organize all the  objects. The object Game is hidden at the top 

of the hierarchy. For example, in Figure 2.10, you can see Workspace parent has the following 

children nested underneath: Camera, Terrain, and Baseplate. 

FIGURE 2.10
Objects nested under       Workspace in the Explorer window.

If you want to   create more child objects, you can hover over Workspace and click the plus sym-

bol to the right (Figure 2.11). This will list all the objects that you can create. You can also drag 

and drop it into the desired parent object.
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FIGURE 2.11
Add more children to        your Workspace.

One of the most important children you will work with is     a part, which is the foundational 

building block of Roblox. These physical 3D objects are also known as bricks, and when they are 

in the Workspace, they can interact with each    other. 

Creating a Part
To    create a part, from the Home tab, navigate to the Insert menu in the ribbon bar and click 

Part (Figure 2.12). 

FIGURE 2.12
Create a      part.

A part will appear at the exact center of your camera view (Figure 2.13). Use the camera con-

trols  shown in Figure 2.14 to move your camera, rotate the view, and zoom in and out.
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FIGURE 2.13
Part appears in your      baseplate and in your Explorer.

FIGURE 2.14
Camera       controls.

To give your     new part a name, do the following:

 1. Double-click the part in your Explorer window.

 2. Rename the part. Roblox convention is for parts to be named in PascalCase, which means 

the first letter is capitalized—for example, EndZone or RedBrick.

Note that your name can contain spaces, but we won’t use spaces at this point in case we want 

to be able to access the part via code later.

You can use the Explorer to select and work with parts even if you can’t see them in the game 

editor    window.

Working with the Properties Window
When    you add a part to your Workspace, you’ll notice the Properties window (Figure 2.15) fills 

with information. 
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FIGURE 2.15
The Properties window      lists all the details about the newly added part.

Like any object, a part    has properties such as size and color, and the Properties window shows all 

these details about how an object looks and behaves. In the next chapter, we’ll go into further 

detail about properties of a part and how you can manipulate       them. 

Translating, Scaling, and Orienting Objects
You’ve learned how to create a part; now you can make it move! In Roblox Studio, it is possible to 

move (translate) and rotate (orient) objects in the scene. There are multiple ways to get the same 

results, but in this section, we will solely use the Roblox Studio default tools and keyboard shortcuts.

There are two settings you can use to get greater control when moving parts: snapping and collisions. 

 Snapping is     the amount a part will move, scale, or rotate at a time. Snapping is useful 

when creating items that need to be exactly aligned, like how walls of buildings need to be 

at 90-degree angles.

 Collisions happen     when two objects (or rigid bodies) intersect or get within a certain range 

of each other.

Because these two settings are most used when playing with two or more parts, turn them off for 

now while you freely move a single part around. Later, you’ll turn them back on when we discuss 

how they work.

 To turn OFF snap: In    the Model tab, uncheck the box next to Rotate or Move (Figure 2.16).

FIGURE 2.16
Turn off   snap.
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 To turn OFF collisions: In   the Model tab, collisions are on if the button is highlighted 

gray. Click the Collisions button to toggle it off (Figure 2.17).

FIGURE 2.17
Turn off   collisions.

Translating
Now     you can freely start translating, or moving, objects. Go to the Model or Home tab and click 

the Move icon (Figure 2.18).

FIGURE 2.18
Move     tool.

Now, a gizmo should appear on the selected objects. When you click, hold, and drag one of the 

arrows, the object moves along that axis (Figure 2.19).

FIGURE 2.19
Moving the     gizmo.
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Scaling
To    scale objects, go to the Model or Home tab and click the Scale icon (Figure 2.20).

FIGURE 2.20
Scale    tool.

The gizmo should appear again, this time with orbs on selected objects. When you click, hold, 

and drag one of the orbs, the object scales along that axis (Figure 2.21). 

FIGURE 2.21
Scaling a    gizmo.

If you want to scale on two sides simultaneously, hold Ctrl (Windows) or Command (Mac) while 

clicking, holding, and dragging one of the orbs. 

If you want to scale while keeping the current proportions, you can do so by holding Shift while 

   scaling.

Rotating
To rotate objects,    go to the Model or Home tab, and click the Rotate icon (Figure 2.22).

FIGURE 2.22
Rotate    tool.
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Another gizmo should appear, now with orbs and circular, connecting lines on selected objects 

(Figure 2.23). When you click, hold, and drag one of the orbs, the object will rotate along that 

axis.

FIGURE 2.23
Rotating a    gizmo.

Transforming
The transform tool    (Figure 2.24) is particularly important as an all-in-one building tool. It 

enables multiple moves, scales, and rotations within one continuous operation. Think of it as a 

bundle of move, scale, and rotate. Basically, it can transform your part in any way possible. It 

also can lock an axis and snap to the grid. 

FIGURE 2.24
Transform    tool.

With your part selected, click on the transform tool and markers for manipulation appear 

around your part (Figure 2.25).
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FIGURE 2.25
Using    the Transform tool.

 The yellow cone is used to move the part on different planes on the Y axis. We can drag 

the part on its own plane once the plane is set.

 The red, green, and blue arcs are used to rotate the part by 360 degrees on the X, Y, and Z 

axes.

 The white boxes are used to scale the side of the part to which they are attached. The scal-

ing happens in the measurement of studs, which is the measurement of each single square 

that forms the    baseplate.

Snapping
Now     that we understand the basics of moving a single part, let’s revisit snapping and collisions. 

As a reminder, snapping is the amount a part will move, scale, or rotate at a time, and it allows 

you to align an object perfectly. There are two  types of snapping: Rotation or Move.

 Rotation snapping  enables you to turn an object by the given number of degrees. In this 

case, all objects will rotate 45 degrees each step.

 Move snapping  counts for both moving and scaling. In this case, any object moves for one 

stud each step. Objects scale one stud each step. 

Keep in mind that when you scale from the center of an object, it will scale one stud on both 

sides. It will then equal two studs total.

To    turn snap back on, you will check the box next to Rotate or Move in the Model tab. Then, in 

the Rotate or Move fields, you can adjust your setting by the number of studs you want to move 

(Figure 2.26).
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FIGURE 2.26
Snapping     options.

Collisions
You     can turn collisions back on and notice how they affect movement. In Roblox Studio, the col-

lisions feature lets you control whether parts can move through each other. When collisions are 

on, you can’t move a part into any place where it overlaps another part.

To turn   collisions back on, click the Collisions button in the Model tab. This toggles it on and 

highlights it gray (Figure 2.27).

FIGURE 2.27
Collisions     on.

Now as you move parts, you may notice a white outline whenever a part touches another part. 

This indicates that a collision is happening. We’ll talk more about collisions in     later hours.

Anchoring
We’ve talked    a lot about making parts move in this chapter, but what if you don’t want a part 

to move? If you want a part to be immobile, you need to anchor it. When you anchor a part, it 

remains static even when you’re playing the game and other players and objects run into it. To 

anchor a part, do the following:

 1. Go to the Properties window.

 2. Scroll down to Behavior.

 3. Check Anchored (Figure 2.28).


